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CHAPTER 1

Plugins

1.1 check-amt-montreal

Checks the numbers of warnings reported by the AMT trains in the Montreal area.

1.2 check-arp-no-change

Verify that a host MAC addresse doesn’t change

1.3 check-asterisk-cdr-status

Shinken plugin from SFL. Check asterisk sql cdr

1.4 check-aws-sqs-activity

Checks the activity of AWS’s simple queue service.

1.5 check-aws-sqs-queue-size

Checks the size of an AWS sqs queue

1.6 check-bixi-montreal

Checks empty or full Bixi (public bike service) stations, in Montreal.

1.7 check-brother-toner-level

Shinken plugin from SFL. Check toner levels of Brother printer by http
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1.8 check-carp-by-ssh

Shinken plugin from SFL. Check carp status on Soekris using ssh

1.9 check-ceilometer

Shinken plugin from SFL. A Nagios plug-in to use OpenStack Ceilometer API for metering

1.10 check-cpu

Shinken plugin from SFL. check CPU usage

1.11 check-emergency-rooms-quebec

Checks the occupation of stretchers in various hospitals in Quebec.

To find pre-defined hospitals configuration, please check [Quebec-monitoring](https://github.com/matthieucan/quebec-
monitoring/blob/master/scripts/hospitals.py)

1.12 check-environment-canada

Checks various environment metrics in Canada.

1.13 check-fake

Shinken plugin from SFL. Fake plugin

1.14 check-graphite-api

Shinken plugin from SFL.

This plugin is made to ensure data freshness into Graphite.

1.15 check-http2

Checks HTTP sites, and doesn’t timeout like good’old check_http.

1.16 check-hydro-quebec

Get the number of service problems

2 Chapter 1. Plugins
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1.17 check-json-by-ec2-tags

Runs check-json on all AWS ec2 instances with a particular tag.

1.18 check-libvirt-stats

Shinken plugin from SFL. Guest and host statistics from libvirt API

1.19 check-linux-bandwidth

check usage bandwidth per month

1.20 check-linux-traffic

Shinken plugin from SFL. Check traffic on linux hosts using /proc/net/dev

1.21 check-mem

Shinken plugin from SFL. Plugin to check memory usage

1.22 check-mpt-status

Shinken plugin from SFL. Check mpt HW RAID controllers status

1.23 check-openbsd-sysstats-byssh

Shinken plugin from SFL. Check OpenBSD system stats using ssh

1.24 check-openerp

Shinken plugin from SFL. Check OpenERP using a web scenario

1.25 check-poller2livestatus

Shinken plugin from SFL. Check Shinken from poller to livestatus module

1.26 check-postgresql-lag

check postgresql streaming latency

1.17. check-json-by-ec2-tags 3
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1.27 check-printer-hp-2600n

Shinken plugin from SFL. Check toner level from a hp 2600n printer

1.28 check-quebecrencontrescom

Checks number of lonely hearts on quebecrencontres.com.

1.29 check-rancid

Shinken plugin from SFL. Check various things from a rancid repo depending on the mode.

1.30 check-reactionner-health

Shinken plugin from SFL. Pseudo crontab to check if a file is edited by shinken reactionner

1.31 check-redis

check redis data base

1.32 check-reseaucontactcom

Checks number of lonely hearts on reseaucontact.com.

1.33 check-samba

Shinken plugin from SFL. Samba server check

1.34 check-selenium

Web scenario tests using Selenium

1.34.1 Firefox Selenium IDE extention

Install Selenium IDE

You need to install Firefox Selenium IDE extension. You can get it HERE

When you got this file, you have to install it in Firefox:

Click on Tools -> Add-ons

4 Chapter 1. Plugins
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Fig. 1.1: Go to Add-ons page

Fig. 1.2: Install Add-on from file...

1.34. check-selenium 5
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On Add-ons page, select Install Add-on from file...*

Select selenium-ide-2.8.0.xpi file on your system

Fig. 1.3: selenium-ide-2.8.0.xpi file

Click on Install Now to install extensions

Configuration

You have to change the default configuration of your Firefox Selenium IDE extention.

To open Selenium IDE window, click on Tools -> Selenium IDE

In Selenium IDE window, open settings by clicking on Options > Options

Then go on Locator Builders tab

Note: You have to put the link item to the bottom of the list

How to create a new scenario

This is an example how to create a new web scenario.

This scenario runs on http://savoirfairelinux.com:

1. sdg

2. sdg

6 Chapter 1. Plugins
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Fig. 1.4: Click on Install Now

Fig. 1.5: Open Selenium IDE window

1.34. check-selenium 7
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Fig. 1.6: Menu Options
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Fig. 1.7: Locators list

1.34. check-selenium 9
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1. First, you have to go to the web page where the web scenario starts. In this case, it’s http://savoirfairelinux.

2. Open Selenium IDE window; Click on Tools -> Selenium IDE

Fig. 1.8: Open Selenium IDE window

3. When the Selenium IDE window is open, please ensure that record button is pushed

4. Now you can start your scenario. The first thing to do is to check if the first page is the good one. So, select any
text in this page, right-click on it and select WaitForText ....

5. In Selenium IDE window, you can check the result of your action. A new line was created with WaitForText
....

6. Now you can continue your scenario. You can now click on Contact Us and wait th page is completely loaded

7. As on the first page, select any text in this page, right-click on it and select WaitForText ....

8. Check the output on Selenium IDE window

Now, you can continue your scenario following this example.

Warning: Please read Recommendations

Save scenario

When you have finished your scenario, you can save it. This is highly recommended because, this is the only way to
edit the scenario in the future ...

To save the sceario, click on File > Save test Case

Export scenario to Python file

In order to use the scenario with the check_selenium plugin, you need to export the scenario to a Python file.

Click on File > Export Test Case As... > Python 2 /unitest / WebDriver

Warning: Use only LOWER CASE letters (a-z) when you export a scenario !!!!!

Note: This file will be used by the check_selenium plugin

10 Chapter 1. Plugins
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Fig. 1.9: Record button

1.34. check-selenium 11



sfl-shinken-plugins, Release 0.1

Fig. 1.10: WaitForText .........
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Fig. 1.11: New line WaitForText ....

1.34. check-selenium 13
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Fig. 1.12: Contact Us page
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Fig. 1.13: WaitForText .........

1.34. check-selenium 15



sfl-shinken-plugins, Release 0.1

Fig. 1.14: New lines in Selenium IDE window
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Fig. 1.15: Save scenario

1.34. check-selenium 17
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Fig. 1.16: Export scenario

18 Chapter 1. Plugins



sfl-shinken-plugins, Release 0.1

Recommendations

Warning: Be carefull about site language:
• When you record the web scenario, you use YOUR Firefox profile with YOUR preferences
• When the web scenerio is played, selenium use a “vanilla” Firefox profile.

So, default site language could be FR/ES/DE with YOUR Firefox but it could EN with “vanilla” Firefox profile.

Danger: Also, when you want to wait a text, choose preferally:
• Short text
• One line text
• Not full uppercase text

1.34.2 How to use the plugin

Requirements

This plugin need:

• selenium==2.44.0

• shinkenplugins==0.1.6

• xvfbwrapper==0.2.4

You can install it, with:

pip install -r requirements.txt

How to use the Plugin

Show help

$ ./check_selenium -h

Launch scenario

$ ./check_selenium -S scenarios -s savoirfairelinuxcom
OK: Scenario execution time: 4.57 seconds

If you get an error/bug in your scenario with the plugin, you can launch it in debug mode. In debug mode, Firefox will
be launched on your display. You will be able to see what Firefox does.

$ ./check_selenium -S scenarios -s savoirfairelinuxcom -d
OK: Scenario execution time: 4.57 seconds

You can also set the size of your Firefox use -W and -H options. This is usefull for scenario on mobile web site.

$ ./check_selenium -S scenarios -s savoirfairelinuxcom -W 400 -H 800
OK: Scenario execution time: 4.57 seconds

Here, the example of command which can be used in your shinken configuration. Don’t forget to add -f option to get
perfdata and get graph.

$ $USER1$/check_selenium -S $SCENARIOS_FOLDER$ -s $ARG1$ -w $ARG2$ -c $ARG3$ -f

1.34. check-selenium 19
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1.35 check-site-health

Shinken plugin from SFL. Browse web site to find broken links

1.36 check-smtp-success-ratio

Shinken plugin from SFL. Given a maillog, checks for a good ratio of sent versus total emails.

1.37 check-snmp-interface

This plugin check interface traffic using SNMP

1.38 check-spa2102

Shinken plugin from SFL. Check Linksys SPA-2102 status

1.39 check-stm-metro-montreal

Checks the current state of the metro in Montreal.

1.40 check_test

TESTTEST

1.41 check-tripplite-ups

Shinken plugin from SFL. Check Tripplite UPSs

1.42 check-wanpipe

Shinken plugin from SFL. Check channels in error with wanpipe

1.43 check-x224

Checks an x224 (RDP) service.

20 Chapter 1. Plugins



CHAPTER 2

Packs

2.1 sfl-generic-carbon-tcp

2.1.1 Dependencies

Shinken Modules

Plugins

check_http

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_http

or

/usr/lib64/nagios/plugins/check_http

Network

This pack will create services which need the following protocol :

• TCP 80 and/or 443 from Poller to monitored client

2.1.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.1.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition

21
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_CARBON_WARN

type Integer

description Warning threshold

_CARBON_CRIT

type Integer

description Critical threshold

2.2 sfl-generic-dhcp

2.2.1 Dependencies

Shinken Modules

Plugins

check_dhcp

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_dhcp

or

/usr/lib64/nagios/plugins/check_dhcp

The plugin permissions should be:

-rwsr-xr-x root root check_dhcp

If not, you can fix it with

sudo chown root: /usr/lib/nagios/plugins/check_dhcp sudo chmod u+s /usr/lib/nagios/plugins/check_dhcp

Network

This pack will create services which need the following protocol :

• UDP 67 and 68 from Poller to monitored client

2.2.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)
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2.2.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition

Triggers

No trigger used with this packs

2.3 sfl-generic-dns

2.3.1 Dependencies

Shinken Modules

Plugins

check_dns

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_dns

or

/usr/lib64/nagios/plugins/check_dns

Network

This pack will create services which need the following protocol :

• UDP 53 and/or TCP 53 from Poller to monitored client

2.3.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.3.3 How to use it

Settings

_DNSHOSTNAME

type string

description Hostname to resolve

2.3. sfl-generic-dns 23



sfl-shinken-plugins, Release 0.1

_DNSEXPECTEDRESULT

type string

description Address expected returned by the DNS server

_DNSWARN

type Integer

description Warning threshold

_DNSCRIT

type Integer

description Critical threshold

Triggers

No trigger used with this pack

2.4 sfl-generic-graphite-http

2.4.1 Dependencies

Shinken Modules

Plugins

check_http

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_http

or

/usr/lib64/nagios/plugins/check_http

Network

This pack will create services which need the following protocol :

• TCP 80 and 443 from Poller to monitored client

2.4.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)
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2.4.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition

_GRAPHITEURL

type string

description The Graphite path. Default: /

_GRAPHITEWARN

type Integer

description Warning threshold. Default: 3

_GRAPHITECRIT

type Integer

description Critical threshold. Default: 5

2.5 sfl-generic-host

2.5.1 Dependencies

Shinken Modules

Plugins

check_ping

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_ping

or

/usr/lib64/nagios/plugins/check_ping

Network

This pack will create services which need the following protocol :

• ICMP
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2.5.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.5.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition

_LOAD_WARN

type 3 comma-separated integer

description Load warning threshold (ie: 7,6,5)

_LOAD_CRIT

type 3 comma-separated integer”,

description Load critical threshold (ie: 10,9,8)”

_STORAGE_USED_WARN

type percent

description Warning level for used storage space

_STORAGE_USED_CRIT

type percent

description Critical level for used storage space

_PROCESS_CRON_MIN_WARN

type integer

description Min number of cron processs, warning threshold

_PROCESS_RSYSLOGD_MIN_WARN

type integer

description Min number of rsyslog processs, warning threshold
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_PROCESS_RSYSLOGD_MIN_CRIT

type integer

description Min number of rsyslog processs, critical threshold

_PROCESS_OSSEC_MIN_WARN

type integer

description Min number of ossec processs, warning threshold

_PROCESS_OSSEC_MIN_CRIT

type integer

description Min number of ossec processs, critical threshold

Triggers

This is the list of triggers used in the pack :

• collectd_cpu.trig

• collectd_df.trig

• collectd_disk.trig

• collectd_interface.trig

• collectd_load.trig

• collectd_memory.trig

• collectd_processes.trig

• collectd_swap.trig

• collectd_users.trig

2.6 sfl-generic-ldap

2.6.1 Dependencies

Shinken Modules

Plugins

check_ldap

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_ldap

or
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/usr/lib64/nagios/plugins/check_ldap

check_ldaps

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_ldaps

or

/usr/lib64/nagios/plugins/check_ldaps

check_tcp

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_tcp

or

/usr/lib64/nagios/plugins/check_tcp

Network

This pack will create services which need the following protocol :

• TCP 636 from Poller to monitored client with SSL

• TCP 389 from Poller to monitored client without SSL

2.6.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.6.3 How to use it

Templates

sfl-generic-ldap

Use this template to monitoring a standard LDAP server.

sfl-generic-ldap3

Use this template to monitoring a LDAP3 server.

sfl-generic-ldaps

Use this template to monitoring a LDAPS server.

28 Chapter 2. Packs



sfl-shinken-plugins, Release 0.1

Settings

This is the list of settings which can be redefined in the host definition

_LDAPBASE

type string

description The read snmp community allowed on the linux server

_DOMAIN

type string

description The read snmp community allowed on the linux server

_DOMAINUSERSHORT

type string

description Short name (without the domain) of the user to query the server. Should have rights on the
WMI tables for reading

_DOMAINUSER

type string

description Full name of the user to query. Is by default DOMAIN\USERSHORT

_DOMAINPASSWORD

type string

description Password for the user that will launch the query

Triggers

2.7 sfl-generic-mongodb

2.7.1 Dependencies

Shinken Modules

Plugins

This pack will create services which need the following plugin :

https://github.com/mzupan/nagios-plugin-mongodb/blob/master/check_mongodb.py

and it here:

/usr/lib/nagios/plugins/check_mongodb.py
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Network

This pack will create services which need the following protocol :

• TCP 27017 to connect with MongoDB

• SSL

2.7.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.7.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition

_MONGO_PORT

type integer

description port of Mongodb

default 27017

_MONGO_CONNECTION_WARNING

type integer

description warning threshold for the connection time to the server

default 2

_MONGO_CONNECTION_CRITICAL

type integer

description critical threshold for the connection time to the server

default 4

_MONGO_PERCENTAGE_CONNECTION_WARNING

type integer

description warning threshold for the connection pool

defaut 70
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_MONGO_PERCENTAGE_CONNECTION_CRITICAL

type integer

description critical threshold for the connection pool

defaut 80

_MONGO_REPLICATION_LAG_WARNING

type integer

description warninig threshold for the lag : second

defaut 15

_MONGO_REPLICATION_LAG_CRITICAL

type integer

description critical threshold for the lag : second

defaut 30

_MONGO_REPLICATION_LAG_PERCENT_WARNING

type integer

description warning threshold for the lag

defaut 50

_MONGO_REPLICATION_LAG_PERCENT_CRITICAL

type integer

description critical threshold for the lag

defaut 75

_MONGO_MEMORY_WARNING

type integer

description warning threshold for usage of ram by MongoDB : gig

defaut 20

_MONGO_MEMORY_CRITICAL

type integer

description critical threshold for usage of ram by MongoDB : gig

defaut 28
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_MONGO_MEMORY_MAPPED_WARNING

type integer

description warning threshold for memory mapped : gig

defaut 20

_MONGO_MEMORY_MAPPED_CRITICAL

type integer

description critical threshold for memory mapped : gig

defaut 28

_MONGO_LOCK_WARNING

type integer

description warning threshold for the lock time : %

defaut 5

_MONGO_LOCK_CRITICAL

type integer

description critical threshold for the lock time : %

defaut 10

_MONGO_FLUSHING_WARNING

type integer

description warning threshold for the average flush time : ms

defaut 100

_MONGO_FLUSHING_CRITICAL

type integer

description critical threshold for the average flush time : ms

defaut 200

_MONGO_LAST_FLUSH_WARNING

type integer

description warning threshold for the last flush time : ms

defaut 200
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_MONGO_LAST_FLUSH_CRITICAL

type integer

description critical threshold for the last flush time : ms

defaut 400

_MONGO_INDEX_MISS_RATIO_WARNING

type float

description warning threshold for the ratio of index hits to misses

defaut .005

_MONGO_INDEX_MISS_RATIO_CRITICAL

type float

description critical threshold for the ratio of index hits to misses

defaut .01

_MONGO_QUERIES_PER_SECOND_WARNING

type integer

description warning threshold for the count of queries

defaut 200

_MONGO_QUERIES_PER_SECOND_CRITICAL

type integer

description critical threshold for the count of queries

defaut 150

_MONGO_CONNECT_PRIMARY_WARNING

type integer

description warning threshold for the connection to the primary server of current replicaset : second

defaut 2

_MONGO_CONNECT_PRIMARY_CRITICAL

type integer

description critical threshold for the connection to the primary server of current replicaset : second

defaut 4
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2.8 sfl-generic-multisite-http

2.8.1 Dependencies

Shinken Modules

Plugins

check_http

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_http

or

/usr/lib64/nagios/plugins/check_http

Network

This pack will create services which need the following protocol :

• TCP 80 and 443 from Poller to monitored client

2.8.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.8.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition

_MULTISITE_USER

type string

description The Multisite admin user login. Default: nagiosadmin

_MULTISITE_PASSWORD

type string

description The Multisite password admin login. Default: nagiosadmin
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_MULTISITE_URL

type string

description The Multisite URL. Default: /check_mk

_MULTISITEWARN

type Integer

description Warning threshold. Default: 3

_MULTISITECRIT

type Integer

description Warning threshold. Default: 5

2.9 sfl-generic-radius

2.9.1 Dependencies

Shinken Modules

Plugins

check_radius

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_radius

or

/usr/lib64/nagios/plugins/check_radius

Network

This pack will create services which need the following protocol :

• UDP : 1645 or 1812 from Poller to monitored client

2.9.2 Installation

Setup the /etc/radiusclient-ng/radiusclient.conf and /etc/radiusclient-ng/servers files properly.

At least, you have to add a line into the servers file for your radius server. Don’t forget to add the secret value!

Setup the /etc/raddb/clients.conf and /etc/raddb/users files properly. The clients.conf file is used to add the poller IP
and set the secret value. The users file is used to define user/password credentials
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2.9.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition

_RADIUSUSER

type string

description The Radius user login. Default: steve

_RADIUSPASSWORD

type string

description The Radius password login. Default: testing

_RADIUSFILE

type string

description The Radius config file path. Default: /etc/radiusclient-ng/radiusclient.conf

_RADIUSPORT

type integer

description The Radius udp port to query. Default: 1812

2.10 sfl-generic-repodeb-http

2.10.1 Dependencies

Shinken Modules

Plugins

check_http

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_http

or

/usr/lib64/nagios/plugins/check_http

36 Chapter 2. Packs



sfl-shinken-plugins, Release 0.1

Network

This pack will create services which need the following protocol :

• UDP 80 and 443 from Poller to monitored client

2.10.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.10.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition

_URI_REPO

type URI

description The URI of the repo to check

2.11 sfl-generic-saltmaster-tcp

2.11.1 Dependencies

Shinken Modules

Plugins

check_dhcp

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_tcp

or

/usr/lib64/nagios/plugins/check_tcp

Network

This pack will create services which need the following protocol :

• TCP 4505 Poller to monitored client

2.11.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)
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2.11.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition

_SALTMASTERPORT

type integer

description Salt master port. Default 4505

_TIME_WARN

type double

description Response time warning threshold. Default 1

_TIME_CRIT

type double

description Response time critical threshold. Default 2

2.12 sfl-generic-smb

2.12.1 Dependencies

Shinken Modules

Plugins

check_samba

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_samba.py

or

/usr/lib64/nagios/plugins/check_samba.py

Network

This pack will create services which need the following protocol :

• TCP 139 from Poller to monitored client
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2.12.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.12.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition

_SMB_USER

type string

description Samba user (Usally from AD). Default : $DOMAINUSERSHORT$

_SMB_PASSWORD

type string

description Samba password. Default : $DOMAINPASSWORD$

_SMB_DOMAIN

type string

description Samba domain. Default : $DOMAIN$

_SMB_SHARED_DIR

type string

description Samba shared directory. Default : Documents

_SMB_TIME_WARN

type integer

description Samba time warning threshold (s). Default 3

_SMB_TIME_CRIT

type integer

description Samba time critical threshold (s). Default 5
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_SMB_TIMEOUT

type integer

description Samba time before timeout (s). Default 10

2.13 sfl-generic-splunk-http

2.13.1 Dependencies

Shinken Modules

Plugins

check_dhcp

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_dhcp

or

/usr/lib64/nagios/plugins/check_dhcp

The plugin permissions should be:

-rwsr-xr-x root root check_dhcp

If not, you can fix it with

sudo chown root: /usr/lib/nagios/plugins/check_dhcp sudo chmod u+s /usr/lib/nagios/plugins/check_dhcp

Network

This pack will create services which need the following protocol :

• UDP 67 and 68 from Poller to monitored client

2.13.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.13.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition
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_SPLUNKAPACHE

type string

description IP of apache server where splunk is. Used if splunk is behind a Apache auth

_SPLUNKURL

type string

description Splunk url on the webserver

_SPLUNKUSER

type string

description Splunk password

_SPLUNKPASSWORD

type string

description Splunk user password

_SPLUNKWARN

type integer

description Response time warning threshold

_SPLUNKCRIT

type integer

description Response time warning threshold

2.14 sfl-generic-ssh

2.14.1 Dependencies

Shinken Modules

Plugins

check_ssh

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_ssh
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or

/usr/lib64/nagios/plugins/check_ssh

Network

This pack will create services which need the following protocol :

• TCP 22 from Poller to monitored client

2.14.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.14.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition

_SSHPORT

type integer

description SSH port. Usually 22

2.15 sfl-linux-ntp-collectd

2.15.1 Dependencies

Shinken Modules

This pack will create services which need the following modules :

• Arbiter/Receiver : mod-collectd

Plugins

This pack will create services which need the following plugins :

Network

This pack will create services which need the following protocol :

• UDP 25826 from monitored client to the Arbiter/Receiver Collectd module
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2.15.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.15.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition

_TIME_OFFSET_WARN

type integer

description offset warning threshold

_TIME_OFFSET_CRIT

type integer

description offset critical threshold

_TIME_DISPERSION_WARN

type integer

description dispersion warning threshold

_TIME_DISPERSION_CRIT

type integer

description dispersion critical threshold

Triggers

This is the list of triggers used in the pack :

• collectd_ntpd.trig

2.16 sfl-linux-radius-collectd

2.16.1 Dependencies

Shinken Modules

This pack will create services which need the following modules :

• Arbiter/Receiver : mod-collectd
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Here an example of a arbiter-collectd module config file:

Plugins

This pack will create services which need the following plugins :

Network

This pack will create services which need the following protocol :

• UDP 25826 from monitored client to the Arbiter/Receiver Collectd module

Collectd

Here an example of a collectd config file:

2.16.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.16.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition

_PROCESS_RADIUS_MIN_WARN

type integer

description Min number of salt master processs, warning threshold

_PROCESS_RADIUS_MIN_CRIT

type integer

description Min number of salt master processs, critical threshold

Triggers

This is the list of triggers used in the pack :

• collectd_processes.trig
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2.17 sfl-linux-saltmaster-collectd

2.17.1 Dependencies

Shinken Modules

This pack will create services which need the following modules :

• Arbiter/Receiver : mod-collectd

Here an example of a arbiter-collectd module config file:

Plugins

This pack will create services which need the following plugins :

Network

This pack will create services which need the following protocol :

• UDP 25826 from monitored client to the Arbiter/Receiver Collectd module

Collectd

Here an example of a collectd config file:

# COLLECTD: custom configuration file used by STM.

# Global options

Hostname "HOSTNAME"

# When the network plugins (network, write_graphite, etc.) take too
# long to respond, limit the metric list stored in memory.
# e.g. When the remote server times out, do not attempt to store all
# the values in memory.
WriteQueueLimitHigh 50
WriteQueueLimitLow 50

######################################################################
# Common plugins for all the machines.

# Activate the logging plugin before all the others
LoadPlugin syslog
<Plugin syslog>

LogLevel info
NotifyLevel WARNING

</Plugin>

# some plugins will be configured in other files
LoadPlugin cpu
LoadPlugin load
LoadPlugin memory
LoadPlugin users
LoadPlugin disk
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LoadPlugin df
LoadPlugin interface
LoadPlugin ntpd
LoadPlugin swap
LoadPlugin processes

# NTP comes from 2 servers
<Plugin ntpd>

Host "10.133.63.17"
Host "10.133.63.19"
Port 123
ReverseLookups false
IncludeUnitID true

</Plugin>

<Plugin df>
IgnoreSelected false
ReportByDevice false
# Also including the reserved space
ReportReserved true
# Free/Used Inodes
ReportInodes true

</Plugin>

<Plugin processes>
Process "shinken-poller.py"
Process "cron"

# Process "rsyslogd"
</Plugin>

# The network plugin send the results to Shinken
LoadPlugin network
<Plugin network>

Server "10.133.63.18" "25826"
</Plugin>

# All the machines will send their data to graphite
LoadPlugin write_graphite
<Plugin write_graphite>

<Node "graphite_server_1">
Host "10.133.63.13"
Port "2003"
Prefix ""
Postfix ".collectd"
Protocol "tcp"
LogSendErrors true

</Node>
<Node "graphite_server_2">

Host "10.133.63.14"
Port "2003"
Prefix ""
Postfix ".collectd"
Protocol "tcp"
LogSendErrors true

</Node>
</Plugin>

######################################################################
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# Search for configuration in the directory
Include "/opt/collectd/etc/conf.d"

# this file is provided by (Minion ID): SHINKENPOLLER

2.17.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.17.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition

_PROCESS_SALTMASTER_MIN_WARN

type integer

description Min number of salt master processs, warning threshold

_PROCESS_SALTMASTER_MIN_CRIT

type integer

description Min number of salt master processs, critical threshold

Triggers

This is the list of triggers used in the pack :

• collectd_processes.trig

2.18 sfl-linux-saltminion-collectd

2.18.1 Dependencies

Shinken Modules

This pack will create services which need the following modules :

• Arbiter/Receiver : mod-collectd

Here an example of a arbiter-collectd module config file:

Plugins

This pack will create services which need the following plugins :
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Network

This pack will create services which need the following protocol :

• UDP 25826 from monitored client to the Arbiter/Receiver Collectd module

Collectd

Here an example of a collectd config file:

# COLLECTD: custom configuration file used by STM.

# Global options

Hostname "HOSTNAME"

# When the network plugins (network, write_graphite, etc.) take too
# long to respond, limit the metric list stored in memory.
# e.g. When the remote server times out, do not attempt to store all
# the values in memory.
WriteQueueLimitHigh 50
WriteQueueLimitLow 50

######################################################################
# Common plugins for all the machines.

# Activate the logging plugin before all the others
LoadPlugin syslog
<Plugin syslog>

LogLevel info
NotifyLevel WARNING

</Plugin>

# some plugins will be configured in other files
LoadPlugin cpu
LoadPlugin load
LoadPlugin memory
LoadPlugin users
LoadPlugin disk
LoadPlugin df
LoadPlugin interface
LoadPlugin ntpd
LoadPlugin swap
LoadPlugin processes

# NTP comes from 2 servers
<Plugin ntpd>

Host "10.133.63.17"
Host "10.133.63.19"
Port 123
ReverseLookups false
IncludeUnitID true

</Plugin>

<Plugin df>
IgnoreSelected false
ReportByDevice false
# Also including the reserved space
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ReportReserved true
# Free/Used Inodes
ReportInodes true

</Plugin>

<Plugin processes>
Process "shinken-poller.py"
Process "cron"

# Process "rsyslogd"
</Plugin>

# The network plugin send the results to Shinken
LoadPlugin network
<Plugin network>

Server "10.133.63.18" "25826"
</Plugin>

# All the machines will send their data to graphite
LoadPlugin write_graphite
<Plugin write_graphite>

<Node "graphite_server_1">
Host "10.133.63.13"
Port "2003"
Prefix ""
Postfix ".collectd"
Protocol "tcp"
LogSendErrors true

</Node>
<Node "graphite_server_2">

Host "10.133.63.14"
Port "2003"
Prefix ""
Postfix ".collectd"
Protocol "tcp"
LogSendErrors true

</Node>
</Plugin>

######################################################################
# Search for configuration in the directory
Include "/opt/collectd/etc/conf.d"

# this file is provided by (Minion ID): SHINKENPOLLER

2.18.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.18.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition
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_PROCESS_SALTMINION_MIN_WARN

type integer

description Min number of salt minion, warning threshold

_PROCESS_SALTMINION_MIN_CRIT

type integer

description Min number of salt minion, critical threshold

Triggers

This is the list of triggers used in the pack :

• collectd_processes.trig

2.19 sfl-linux-system-collectd

2.19.1 Dependencies

Shinken Modules

This pack will create services which need the following modules :

• Arbiter/Receiver : mod-collectd

Here an example of a arbiter-collectd module config file:

## Module: Collectd
## Loaded by: Arbiter, Receiver
# Receive passive host and service results from a collectd daemon.
define module {

module_name Collectd
module_type collectd

#
# Specify exact host (optional)

host 0.0.0.0
port 25826

# port 25827
# multicast False
grouped_collectd_plugins cpu,df,disk,interface,ntpd

}

# this file is provided by (Minion ID): SHINKENFULL

Plugins

This pack will create services which need the following plugins :
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Network

This pack will create services which need the following protocol :

• UDP 25826 from monitored client to the Arbiter/Receiver Collectd module

Collectd

Here an example of a collectd config file:

# COLLECTD: custom configuration file used by STM.

# Global options

Hostname "HOSTNAME"

# When the network plugins (network, write_graphite, etc.) take too
# long to respond, limit the metric list stored in memory.
# e.g. When the remote server times out, do not attempt to store all
# the values in memory.
WriteQueueLimitHigh 50
WriteQueueLimitLow 50

######################################################################
# Common plugins for all the machines.

# Activate the logging plugin before all the others
LoadPlugin syslog
<Plugin syslog>

LogLevel info
NotifyLevel WARNING

</Plugin>

# some plugins will be configured in other files
LoadPlugin cpu
LoadPlugin load
LoadPlugin memory
LoadPlugin users
LoadPlugin disk
LoadPlugin df
LoadPlugin interface
LoadPlugin ntpd
LoadPlugin swap
LoadPlugin processes

# NTP comes from 2 servers
<Plugin ntpd>

Host "10.133.63.17"
Host "10.133.63.19"
Port 123
ReverseLookups false
IncludeUnitID true

</Plugin>

<Plugin df>
IgnoreSelected false
ReportByDevice false
# Also including the reserved space
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ReportReserved true
# Free/Used Inodes
ReportInodes true

</Plugin>

<Plugin processes>
Process "shinken-poller.py"
Process "cron"

# Process "rsyslogd"
</Plugin>

# The network plugin send the results to Shinken
LoadPlugin network
<Plugin network>

Server "10.133.63.18" "25826"
</Plugin>

# All the machines will send their data to graphite
LoadPlugin write_graphite
<Plugin write_graphite>

<Node "graphite_server_1">
Host "10.133.63.13"
Port "2003"
Prefix ""
Postfix ".collectd"
Protocol "tcp"
LogSendErrors true

</Node>
<Node "graphite_server_2">

Host "10.133.63.14"
Port "2003"
Prefix ""
Postfix ".collectd"
Protocol "tcp"
LogSendErrors true

</Node>
</Plugin>

######################################################################
# Search for configuration in the directory
Include "/opt/collectd/etc/conf.d"

# this file is provided by (Minion ID): SHINKENPOLLER

2.19.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.19.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition
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_LOAD_WARN

type 3 comma-separated integer

description Load warning threshold (ie: 7,6,5)

_LOAD_CRIT

type 3 comma-separated integer”,

description Load critical threshold (ie: 10,9,8)”

_STORAGE_USED_WARN

type percent

description Warning level for used storage space

_STORAGE_USED_CRIT

type percent

description Critical level for used storage space

_PROCESS_CRON_MIN_WARN

type integer

description Min number of cron processs, warning threshold

_PROCESS_CRON_MIN_CRIT

type integer

description Min number of cron processs, critical threshold

_PROCESS_RSYSLOGD_MIN_WARN

type integer

description Min number of rsyslog processs, warning threshold

_PROCESS_RSYSLOGD_MIN_CRIT

type integer

description Min number of rsyslog processs, critical threshold
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_PROCESS_OSSEC_MIN_WARN

type integer

description Min number of ossec processs, warning threshold

_PROCESS_OSSEC_MIN_CRIT

type integer

description Min number of ossec processs, critical threshold

Triggers

This is the list of triggers used in the pack :

• collectd_cpu.trig

• collectd_df.trig

• collectd_disk.trig

• collectd_interface.trig

• collectd_load.trig

• collectd_memory.trig

• collectd_processes.trig

• collectd_swap.trig

• collectd_users.trig

2.20 sfl-vmware-system-https

2.20.1 Dependencies

Shinken Modules

Plugins

check_vmware_api.pl

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_vmware_api.pl

or

/usr/lib/64nagios/plugins/check_vmware_api.pl
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Network

This pack will create services which need the following protocol :

• TCP 80 and 443 from Poller to monitored client

2.20.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.20.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition

_ESX_CPU_WARN

type percent

description Level for cpu usage

_ESX_CPU_CRIT

type percent

description Level for cpu usage

_ESX_MEM_WARN

type percent

description Level for ram usage

_ESX_MEM_CRIT

type percent

description Level for ram usage

_ESX_SWAP_WARN

type percent

description Level for swap usage
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_ESX_SWAP_CRIT

type percent

description Level for swap usage

2.21 sfl-windows-ad-collectd

2.21.1 Dependencies

Shinken Modules

Plugins

check_dhcp

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_dhcp

or

/usr/lib64/nagios/plugins/check_dhcp

The plugin permissions should be:

-rwsr-xr-x root root check_dhcp

If not, you can fix it with

sudo chown root: /usr/lib/nagios/plugins/check_dhcp sudo chmod u+s /usr/lib/nagios/plugins/check_dhcp

Network

This pack will create services which need the following protocol :

• UDP 67 and 68 from Poller to monitored client

2.21.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.21.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition
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_LOAD_WARN

type 3 comma-separated integer

description Load warning threshold (ie: 7,6,5)

_LOAD_CRIT

type 3 comma-separated integer”,

description Load critical threshold (ie: 10,9,8)”

_STORAGE_USED_WARN

type percent

description Warning level for used storage space

_STORAGE_USED_CRIT

type percent

description Critical level for used storage space

_PROCESS_CRON_MIN_WARN

type integer

description Min number of cron processs, warning threshold

_PROCESS_RSYSLOGD_MIN_WARN

type integer

description Min number of rsyslog processs, warning threshold

_PROCESS_RSYSLOGD_MIN_CRIT

type integer

description Min number of rsyslog processs, critical threshold

_PROCESS_OSSEC_MIN_WARN

type integer

description Min number of ossec processs, warning threshold
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_PROCESS_OSSEC_MIN_CRIT

type integer

description Min number of ossec processs, critical threshold

Triggers

This is the list of triggers used in the pack :

• collectd_cpu.trig

• collectd_df.trig

• collectd_disk.trig

• collectd_interface.trig

• collectd_load.trig

• collectd_memory.trig

• collectd_processes.trig

• collectd_swap.trig

• collectd_users.trig

2.22 sfl-windows-mssql

2.22.1 Dpendencies

Shinken Modules

Plugins

check_dhcp

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_mssql_health

or

/usr/lib64/nagios/plugins/check_mssql_health

This plugin is available here : http://labs.consol.de/lang/en/nagios/check_mssql_health/

Network

This pack will create services which need the following protocol :

• TCP 1433 from Poller to monitored client
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2.22.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.22.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition

_MSSQL_CONNECTION_CRIT

type string

description Time to connect to the server

_MSSQL_CONNECTION_WARN

type string

description Time to connect to the server

_MSSQL_CONNECTED_USERS_CRIT

type string

description Number of currently connected users

_MSSQL_CONNECTED_USERS_WARN

type string

description Number of currently connected users

_MSSQL_CPU_BUSY_CRIT

type percent

description Cpu busy in percent

_MSSQL_CPU_BUSY_WARN

type percent

description Cpu busy in percent
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_MSSQL_IO_BUSY_CRIT

type percent

description IO busy in percent

_MSSQL_IO_BUSY_WARN

type percent

description IO busy in percent

_MSSQL_FULL_SCANS_CRIT

type string

description Full table scans per second

_MSSQL_FULL_SCANS_WARN

type string

description Full table scans per second

_MSSQL_TRANSACTIONS_CRIT

type string

description Transactions per second per database

_MSSQL_TRANSACTIONS_WARN

type string

description Transactions per second per database

_MSSQL_BATCH_REQUESTS_CRIT

type string

description Batch requests per second

_MSSQL_BATCH_REQUESTS_WARN

type string

description Batch requests per second
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Triggers

2.23 sfl-windows-rdp

2.23.1 Dependencies

Shinken Modules

Plugins

check_x224

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_x224

or

/usr/lib64/nagios/plugins/check_x224

Network

This pack will create services which need the following protocol :

• TCP 3389 from Poller to monitored client

2.23.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.23.3 How to use it

Settings

2.24 sfl-windows-sophos-collectd

2.24.1 Dependencies

Shinken Modules

This pack will create services which need the following modules :

• Arbiter/Receiver : mod-collectd

Here an example of a arbiter-collectd module config file:

## Module: Collectd
## Loaded by: Arbiter, Receiver
# Receive passive host and service results from a collectd daemon.
define module {

module_name Collectd
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module_type collectd
#
# Specify exact host (optional)

host 0.0.0.0
port 25826

# port 25827
# multicast False
grouped_collectd_plugins cpu,df,disk,interface,ntpd

}

# this file is provided by (Minion ID): SHINKENFULL

Plugins

This pack will create services which need the following plugins :

Network

This pack will create services which need the following protocol :

• UDP 25826 from monitored client to the Arbiter/Receiver Collectd module

Collectd

Here an example of a collectd config file:

# COLLECTD: custom configuration file used by STM.

# Global options

Hostname "HOSTNAME"

# When the network plugins (network, write_graphite, etc.) take too
# long to respond, limit the metric list stored in memory.
# e.g. When the remote server times out, do not attempt to store all
# the values in memory.
WriteQueueLimitHigh 50
WriteQueueLimitLow 50

######################################################################
# Common plugins for all the machines.

# Activate the logging plugin before all the others
LoadPlugin syslog
<Plugin syslog>

LogLevel info
NotifyLevel WARNING

</Plugin>

# some plugins will be configured in other files
LoadPlugin cpu
LoadPlugin load
LoadPlugin memory
LoadPlugin users
LoadPlugin disk
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LoadPlugin df
LoadPlugin interface
LoadPlugin ntpd
LoadPlugin swap
LoadPlugin processes

# NTP comes from 2 servers
<Plugin ntpd>

Host "10.133.63.17"
Host "10.133.63.19"
Port 123
ReverseLookups false
IncludeUnitID true

</Plugin>

<Plugin df>
IgnoreSelected false
ReportByDevice false
# Also including the reserved space
ReportReserved true
# Free/Used Inodes
ReportInodes true

</Plugin>

<Plugin processes>
Process "shinken-poller.py"
Process "cron"

# Process "rsyslogd"
</Plugin>

# The network plugin send the results to Shinken
LoadPlugin network
<Plugin network>

Server "10.133.63.18" "25826"
</Plugin>

# All the machines will send their data to graphite
LoadPlugin write_graphite
<Plugin write_graphite>

<Node "graphite_server_1">
Host "10.133.63.13"
Port "2003"
Prefix ""
Postfix ".collectd"
Protocol "tcp"
LogSendErrors true

</Node>
<Node "graphite_server_2">

Host "10.133.63.14"
Port "2003"
Prefix ""
Postfix ".collectd"
Protocol "tcp"
LogSendErrors true

</Node>
</Plugin>

######################################################################
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# Search for configuration in the directory
Include "/opt/collectd/etc/conf.d"

# this file is provided by (Minion ID): SHINKENPOLLER

2.24.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.24.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition

_MSSQL_SOPHOS_INSTANCES

type Comma separated string list

description MSSQL Instances for Sophos. Default : SOPHOS (only one element)

_PROCESS_SOPHOS_MIN_WARN

type integer

description Min number of Sophos processes, warning threshold

_PROCESS_SOPHOS_MIN_CRIT

type integer

description Min number of Sophos processes, critical threshold

Triggers

This is the list of triggers used in the pack :

• windows_collectd_service.trig

• windows_collectd_processes.trig
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2.25 sfl-windows-sophos-mssql

2.25.1 Dependencies

Shinken Modules

Plugins

check_dhcp

This pack will create services which need the following plugin:

/usr/lib/nagios/plugins/check_dhcp

or

/usr/lib64/nagios/plugins/check_dhcp

The plugin permissions should be:

-rwsr-xr-x root root check_dhcp

If not, you can fix it with

sudo chown root: /usr/lib/nagios/plugins/check_dhcp sudo chmod u+s /usr/lib/nagios/plugins/check_dhcp

Network

This pack will create services which need the following protocol :

• UDP 67 and 68 from Poller to monitored client

2.25.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.25.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition

_DOMAINPASSWORD

type string

description domain password
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_MSSQLUSER

type string

description MSSQL user

_MSSQLPASSWORD

type string

description MSSQL password

_INFECTED_SERVERS_WARN

type integer

description warning threshold for infected servers count

_INFECTED_SERVERS_CRIT

type integer

description critical threshold for infected servers count

2.26 sfl-windows-system-collectd

2.26.1 Dependencies

Shinken Modules

This pack will create services which need the following modules :

• Arbiter/Receiver : mod-collectd

Here an example of a arbiter-collectd module config file:

Plugins

This pack will create services which need the following plugins :

Network

This pack will create services which need the following protocol :

• UDP 25826 from monitored client to the Arbiter/Receiver Collectd module

Collectd

Here an example of a collectd config file:
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2.26.2 Installation

Copy the pack folder in the packs folder defined in shinken.cfg (cfg_dir=packs)

2.26.3 How to use it

Settings

This is the list of settings which can be redefined in the host definition

_LOAD_WARN

type 3 comma-separated integer

description Load warning threshold (ie: 7,6,5)

_LOAD_CRIT

type 3 comma-separated integer”,

description Load critical threshold (ie: 10,9,8)”

_PROCESS_CRON_MIN_WARN

type integer

description Min number of cron processs, warning threshold

_PROCESS_RSYSLOGD_MIN_WARN

type integer

description Min number of rsyslog processs, warning threshold

_PROCESS_RSYSLOGD_MIN_CRIT

type integer

description Min number of rsyslog processs, critical threshold

_PROCESS_OSSEC_MIN_WARN

type integer

description Min number of ossec processs, warning threshold
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_PROCESS_OSSEC_MIN_CRIT

type integer

description Min number of ossec processs, critical threshold

Triggers

This is the list of triggers used in the pack :

• windows_collectd_counter.trig

• windows_collectd_counter_multiple.trig

• windows_collectd_cpu.trig

• windows_collectd_df.trig

• windows_collectd_disk.trig

• windows_collectd_interface.trig

• windows_collectd_memory.trig

• windows_collectd_memory-pagefile.trig

• windows-collectd_process.trig

• windows-collectd_processes.trig

• windows-collectd_service.trig

• windows-collectd_users.trig
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